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Introduction
Syntrax for Pocketpc is a small music composer what you can use wherever you are.
Syntrax can use samples as well as real-time sound synthesis. From the design of
complex sounds, to the composition of a complete song, you can do just about
everything with it.

Songs can be saved to the PocketPC and can be imported with the PC version.
From here you can even export the song as a wav file, enabling you to make an mp3
of it or record it onto a CD-R. Future versions of Syntrax will also be able to export
directly to a MIDI file format, so you can read it in other popular music programs like
Cubase.

We advise you to first do the small tutorial called 'quick start' as explained further on.
It will help you grasp some fundamental concepts of the program hands on.
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Important Notes
Syntrax can use a lot of processor power to render its songs. If you find that you
can't play certain songs, please go to the settings screen and set the output audio
format to a lower setting. This way, the processor has to do less and playback works
better.

We found that on older IPAQs the sound quality is poor. The audio hardware of first
IPAQs doesn't seem to be able to play at 44100 KHz. Also, sound artifacts can be
heard throughout the songs. This has nothing to do with Syntrax but with faulty audio
hardware.

Note that your finished songs can be played back on the Desktop version of Syntrax
in full audio quality and exported to a .wav file. The desktop version of Syntrax can
be found at http://www.klaar.com.
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Quick Start
This section will let you make a simple song within 1 - 2 minutes. It explains the
fundamentals and gives you a flying start.

Please follow the steps as described:

• Start Syntrax for PocketPC
• Click the Splash screen with the credits away. (Click on the start button)
• You are now in the Song editor. This screen let's you arrange your song.
• Using the menu bar on the top of the screen you can easily navigate between the

various screens.
• tap on 'I' on the menu bar at the top of the screen to go to the Instrument editor
• In the instrument editor you can edit and create the instruments you will use for

your composition. To load an existing instrument go to the menu bar and tap on
'FILE' and then choose 'Load Instrument'.

• A file dialog opens where you can choose an instrument.
• Double click on 'My Documents' and the click on 'syntrax' to see all instruments

which are pre-installed.
• Choose 'Acoustimass.jxi'.
• You can see the various parameters set for this instrument.
• If you want to hear the instrument click on the hardware keys of your device.
• To heighten the pitch of the sound, press the 'Up' or 'Right' hardware key, and

press the 'Down' or 'Left' hardware keys to lower the pitch.
• To change the sound parameters, just move the dials on the screen. For instance,

to change the volume, just slide the slider with 'volume' next to it. All your
changes can be heard in real-time.

• Almost all parameters can be set dynamically. We use waveforms to control how
the various parameters should change over time. Let's change the frequency for
instance.

• If you doodle in the small waveform display under the word 'frequency' you can
actually draw how the frequency should change over time.

• Draw a little bit in the waveform and listen to the new sound using the hardware
keys. You should be able to hear how the frequency changes.

• If you want the frequency to change faster, then use the 'Spd' Dial right under the
small frequency waveform display.

• If you want to hear the sound longer, just doodle another wave into the volume
waveform. Or you could even set the waveform speed to 0, making sure the
volume won't change over time anymore.

• There are 16 waveforms available for these kind of things. To select another
waveform from the available wavebank, click on the word 'frequency' just above
the frequency waveform display. (Or similarly click on the word 'timbre' , 'volume'
or 'panning')

• The screen you are presented with now is the waveband screen. In this screen
you see all 16 available waveforms, from which one can be selected.

• If you want to more precisely edit a waveform from the waveband, you can click
on the 'edit' button. This button will bring you to a dedicated waveform edit
screen.

• Please note that if you are listening to the instrument that you are editing, it is
possible that the waveform appears to be animating. This is because it is possible
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to have the Waveforms be manipulated via effects in real time. These effects can
be set in the Wavefx screen. But you can read more about that in the appropriate
section of this help file.

• Tap the 'P' button on the menu bar at the top of the screen.
• You are now in the pattern editor. The pattern editor is the place where you can

compose small repetitive pieces of music. In the song editor you can arrange
these little fragments into a big song.

• Click on the 'NOTE' button. This will enable the 'note drawing' mode. The
instrument you are going to insert is still selected in the selection box below this
button. If not please select it first.

• Now start doodling some notes on the score.
• If you are ready click the 'play' button on the menu at the top of the screen (the

small triangle in the menu bar). You will now hear your masterpiece.
• If you continue to doodle you will hear the changes you make in real-time.
• A pattern is 64 notes long, but you can only see 16 of them at a time. To see the

next 16 patterns, alter the 'step' number. If you want the pattern to repeat after
only 16 notes, set the 'playlength' control to 16 

• Every note can have a special effect attached to it. Usually you would use the
'slide' effect which let's a note 'slide' to another. To accomplish this click on the
'slide' button.

• Now click on an empty place somewhere on the score.
• To set the speed of the slide you have to click the 'Amount' button.
• Click on the sliding note to set the speed of the slide. The slide can be either

down frequency goes lower) or up (frequency goes up).
• Now tap on the 'S' button on the menu bar at the top of the screen. This is the

song editor; here you can arrange all the patterns you have made into a song.
• Per default, the first pattern is already selected on channel 1. If you want to insert

another pattern, or other patterns, select the pattern you want to insert with the
'pattern' drop-down box and then click somewhere on the grid. To actually insert
click on the 'ins' button.  Similarly use the 'del' button to remove a pattern and
use the 'trim' button to make a pattern shorter (e.g. only play 16 notes instead of
64)

• If you click on the 'play' button on the menu bar at  the top of the screen the song
will be played.

• To set the amount of echo on this channel click on the box with the '000' in it next
to the channel.

• While pressing down on the '000' drag the stylus down to increase the amount in
the box.

• If you click on the 'SHOW' tab in the bottom part of the screen, a pane with all
kind of controls will be made visible. These controls enable you to set the speed,
the amplification and the actual loop points and start points of the song.

You have now seen how you can easily load instruments, create patterns and
arrange them into a song. There is much more to discover. Like the sample editor,
all the fancy real time synthetic effects and much more.  You can read the
appropriate chapters if you don't understand something, or just start playing.
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Navigating the Program
The program consists of various small screens or editors. These screens can be
navigated using the 'S', 'P' and 'I' button on the menu bar at the top of the screen.

Pressing any one of those buttons at anytime will take you to the corresponding
screen.

There are other editors that can only be accessed by pressing buttons on the main
screen. How to get to all the screens will be discussed in the appropriate chapters

The Various Editors
• The song editor. This is the screen in which you start. If you press 'S' at any time

you will come back to this screen. In this screen you can arrange the various
patterns with notes you have made previously in the pattern editor.

• The pattern editor.  This is the screen in which you can edit the patterns of notes.
A pattern is nothing more than a 'bar' of notes which can be played over and over
again. The notes are played using instruments the which you have loaded
previously in the instrument editor. To get to this screen tap the 'P' button on the
menu bar at the top of the screen.

• The instrument editor.   This is the screen in which you can load all the
instruments you are going to use for your song. These instruments can be divided
into 2 categories: samples or synthetic sounds. In this screen you can also alter or
fine-tune the sounds you are using. Click on the 'I' button on the menu bar at the
top of the screen to go to this screen at any given moment.

On the menu bar you will also find a 'Play' button (A small yellow triangle). This, as
the name suggests, will start playback of the song. If the song is already playing, a
'Stop' button (A small yellow square) will be present at the same place. In the Song
editor, the Play button will playback the whole song. In the pattern editor it will only
play the pattern you are editing 

To alter the values of various controls of the screen, typically hold down the stylus,
and then drag it to change the values. 

Finally you will find two menus in the menu bar. The first one is the 'File' menu, used
to load and save your song, load and save your individual instruments and even load
or save individual patterns. Please note that when you save your song, it will save
the entire package, including all used instruments and patterns. This is to make sure
that you won't alter an existing song per accident. From this menu you can also find
the settings. It is here that you can set the sound quality at which you want Syntrax
to render the songs. Higher settings require faster machines. If you have a
PocketPC equipped with a StrongARM or an Xscale processor then don't worry, you
can probably set it at its best setting. Slower machines (Sh3 processors most
notably) should try lower quality settings. If the quality is set too high the machine will
noticably struggle and can even come to a complete halt. Syntrax will detect when
too much processor power is used and may even decide to quit audio playback. If
this happen, go to the settings screen and select a lower quality. You can easily
choose a preset from the drop-down box and the settings are changed accordingly.
The notes off menu item is in case you have made an instrument which never stops.
All notes off stops playback immediately and flushes any existing audio buffers.

The Edit menu is only used in the pattern and the song menu and will be discussed
in both sections.
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The Instrument Editor

The instrument editor is a very important screen. You can always get here by
pressing the 'I' on the menu bar at the top of the screen.  It is from here that you can
load and alter the instruments you are going to use in your song. Please note that if
you alter an instrument here, you won't change the original instrument. Only when
you explicitly save this instrument will it altered and be available for other songs. If
you save your song, all instruments are saved in the song, so you don't need to
worry about which instrument belongs to which song.

From the File menu you can load an instrument. For example load the instrument
called '909snare'.  The loaded instrument is automatically selected. You can hear it
by clicking the hardware buttons. To change the pitch, use the 'Up', 'Down', 'Left' and
'Right' hardware buttons on your device. If you have loaded more than 1 instrument
you can select another one by clicking on the instrument drop-down box on the
upper-left corner of the screen. All instruments will be listed. The button New right to
the drop-down box enables you to make an instrument from scratch. The Del button
deletes the currently selected instrument.

As you can see there are 4 waves listed on the page. The Timbre wave, the Volume
wave, the Frequency wave and the Panning wave. Each of these waves is a
waveform which can oscillate the given sound characteristic. For instance just draw
into one of the waveforms and you can hear the changes you make by playing the
sound with the hardware button of your device. Especially changes to the frequency
wave are easy to hear. Each wave describes the change of the amplitude (volume),
frequency, and panning over time. 

If you want to precisely edit the waveform click on the name of the waveform just
above the waveform display. This will open up a new screen called the
'WAVEBANK'. From this bank of waveform you can either select another of the 16
available waveforms, or you can choose to edit one. If you click on edit you are
brought to the WAVEFORM EDITOR. Read more about it in its own chapter. To get
back to the instrument editor click on the 'I' on the menu bar at the top of the screen.
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The Frequency waveform is how the frequency of the sound changes over time.
Use this to simulate a vibrato in the sound or make a siren. The Panning wave
enables you to pan the sound from left to right and vice versa. The Timbre wave is
the actual waveform which is heard when you play the sound. The sound that you
have loaded now is a sample and so doesn't use a waveform. This is why the
waveform is greyed-out. If you where to load another sound, for instance
'acoustimass' and try to edit the timbre wave… you will hear the sound change
every time you draw into the wave. If the sound is a sampled sound, you can press
the 'sample' button to go to the SAMPLE EDITOR. This is explained in the chapter
with the same name.

To make complex changes to the waveform in real time, you would use the 'wavefx'
button located on the bottom of the screen. This will take you to the WAVEFX screen
in which you can manipulate all of the 16 waveforms in the wavebank using effects
like filters and morphs. More on the WAVEFX screen in the appropriate chapter.

The mastervol button is a slider which can vary from soft to loud. The finetune
button let's you fine tune the frequency of the sound. This is necessary for some
sampled sounds if they are off key in respect to the other sounds used. The
Arpeggio button let's you add a preset 'arpeggio' effect to the sound. An arpeggio is
a fast change of notes with which you can simulate a chord.
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The Pattern Editor

The pattern editor is where you take the instruments you have loaded and start
composing. Click the [P] button on the menu bar at the top of the screen to go to the
pattern editor. To create a new pattern click on the 'New' button on the top of the
screen. To select a previously created pattern click on the drop-down box next to it to
select it. If you want to remove a pattern click the 'Del' button. 

The note bar depicts how the notes in the pattern are arranged. The higher the note,
the higher it is played. The actual note is listed on the right of the bar. The octave
you are looking at is shown by the 'octave' control on the top-left part of the screen.
If you alter the octave, you are seeing another part of the pattern. If you select a
previously created pattern and you don't see any notes, be sure to browse through
the octaves until you find your notes.

To edit notes you first need to set the editor into the NoteEdit mode. You do this by
clicking on the 'Note' button. Next, select the instrument which you want to insert in
the pattern. You do this by using the drop-down box in the bottom left of the screen
(under the 'Note' button). Now if you tap on the note bar you will see a blue box
appear. A blue box means that a note will be played there. If you click on the 'Play'
button on the menu bar at the top of the screen (the small yellow triangle), you can
actually hear what you are doing.

If you want to delete a note, click the 'Clr' button, this will set the editor in erase
mode. Now tap on the notes you want to erase.

An instrument initializes itself every time you play a note. If you want to play a note
without the instrument to initialize itself, select 'No Init' from the instrument drop-
down box. If you now go to Note edit mode and tap on the note bar.  You will see an
empty box instead of a blue one. This means that the note will be played with the last
played instrument, but that this instrument won't be reinitialized.

To quickly alter a pattern in it's totality use the 'Edit' menu. This menu contains
various functions which takes a long time if you have to do it manually. You can for
instance transpose the whole pattern by 1 note or an octave.
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Last but not least it is possible to edit or tweak the various sounds from within a
pattern. We have dubbed this 'special fx'. Among the special fx is also the possibility
to glide one note to the other (usually called portamento on synthesizers).

Every note on the note bar can have an effect assigned to it. Since the Slide (or
portamento) is the most commonly used we have added a special mode for it.

Click on the 'Slide' button to set the editor in freq-slide mode. Now click anywhere in
the pattern. You'll see a red box appearing. This red box indicated the note to which
the currently playing note should be bend. This by itself is not enough, you also have
to set the speed by which the bending should occur. You do this by clicking on the
'Amount' button and setting the editor to 'effect amount mode'. If you click under or
above the red box you should see a black box appear which indicates the speed of
the bend. Please note that there is a distinction between positive and negative
speeds (The note goes up or down).

These options are what you'll be typically using. If you are a more advanced user
please read on:

A note slide is not the only thing you can do with the special fx in Syntrax. You can
also alter the various instrument settings from within the pattern. You can do this by
clicking on the 'Fx' button. This sets the editor in effects mode. Now select an effect
from the drop-down box next to the instrument drop-down box. This box gives a list
of all the available effects. The most commonly used is the volume effect. With this
you can change the volume of the instrument while the pattern is playing. All the
waveform effect parameters can also be changed. These settings change the
parameters of the synthetic sounds. This way you can get really complex sounds. As
an example on how to insert an effect we will change the volume in the pattern. Click
on the 'Fx' button. Select the 'Volume' effect from the drop-down box. Now click on a
previously inserted note on the note bar. The note will change into a lighter shade of
blue, indicating that an effect is attached. Now click on the 'Amount' button and set
the amount of the new volume by clicking under or above the light blue box. A black
bar will appear indicating the new volume.

Please note that from this point on the volume remains altered. To change the
volume back you have to attach another effect a few notes further in the pattern and
set the volume to a new setting.
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The Song Editor

After creating various patterns (like a drum track, a bass line and a melody) you
have to arrange them into a song. You go to the song editor by clicking on the [S]
button on the menu bar at the top of the screen. The song editor has 8 channels on
which it can play any of the patterns you have created. It doesn't matter which
channel you use for which pattern, it all sounds the same. If you look closely at the
editor, you'll see the 8 channels listed under each other. If you don't see 8 channels
it is possible that the screen is folded up to show the song controls instead of the
patterns making up a song. To fold/unfold the song screen click on the 'Show'
and/or 'Hide' tab.

To insert patterns into the song, first select the pattern which you want to insert. Use
the 'Pattern' drop-down box to select the pattern you want to insert. Then click
anywhere in the graphical display of the song to select where you want to insert the
pattern. Finally click on the 'Insert' button (or use the insert option from the edit
menu).

To remove a pattern from the song, select it from the graphical display and click on
the 'del' button.

Finally, to play only a part of a pattern (e.g. only 16 notes from a 64 note pattern) first
select at which point you want the selection to snap. Select the snap from the 'snap'
drop-down box to specify the granularity. Now click on the exact point of a pattern
you want to shorten. Finally press the 'trim' button or select the trim option from the
edit menu.
If you are ready sequencing the patterns click on 'Play' on the menu bar at the top of
the screen (the small yellow triangle). You will hear all the patterns be played
simultaneously. To edit one of the patterns, select it in the graphical display and
select 'go to pattern' from the edit menu. Or just go to the pattern editor manually
and select the pattern there. If you want to change the speed of the song click on the
'BPM' button with the stylus and hold it down, then drag it to change its value!  Bpm
stands for Beats Per Minute and is an indication on how fast the song should be
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played. The groove of the song can be altered with the BPM drop-down box. You
can set it so that the song plays smoothly or changes into a shuffle, which can
greatly increase how much the song 'swings'. The small buttons in front of each
channel let's you temporarily mute a channel. This is useful if you want to quickly
hear how the song sounds without the channel activated.

Now you can set how long the song is… you do this by setting the 'Songstart', the
'Songend' and the 'Songloop' buttons. These settings indicate how many steps the
song contains and where it should restart if it comes to the end. 

The graphical display will also show you the start, loop and end points in a graphical
manner.

The 'Amplification' button let's you set the final amplification of the song. Usually an
amount of 400 sounds okay. But if you use sounds with a low volume you may need
to set it higher.

There is also a possibility to add echo to the song. You can set the amount of echo
on every individual channel by using the button on the rightmost place behind the
channel. An amount of 255 is the maximum, 0 means no echo. The speed of the
echo is set by the 'Delay time' button on the bottom of the screen. The lower the
value, the faster the echoes.
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The Waveform Editor

The waveform editor was mentioned before in the chapter about the  instrument
editor. The only way to get to the waveform editor is from the waveband screen
which you can access from the instrument editor (see the chapter about the
instrument editor).

To give an example how to get to the waveform editor: go to the instrument editor
(using the 'I' on the menu bar at the top of the screen). Now click on any of the
names above the small waveform displays. This will bring you to the waveband
screen. Now click on the 'edit' button and voila you are in the waveform editor.

By drawing into the waveform display you can directly alter the waveform.

You can also select a predefined waveform from the 'presets' drop-down list.
You can also use the 'operation' drop-down list to select an operation you want to
perform on the waveform. Select the 'go' button to actually perform the operation. 

Available Waveform Operations
Downsample – Makes the waveform twice as long, which makes it sound 1
octave lower.

Upsample – Makes the waveform twice as short, making it sound one octave
higher.

Scroll left – Scrolls the waveform to the left.

Scroll right – Scrolls the waveform to the right.

Copy – Copies the waveform into a temporary buffer.

Flip-X – Flips the waveform around its imaginary vertical axis.

Flip-Y – Flips the waveform around its imaginary horizontal axis.

Scroll up – Scrolls the waveform up.
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Scroll down – Scrolls the waveform down.

Paste – Replaces the waveform with the one from the temporary buffer.

Louder – Scales the waveform so that it sounds louder.

Softer – Scales the waveform so that it sounds softer

Add Noise – adds white noise to the waveform

Smooth – Smooths the rough edges of the waveform making it sound more
smooth.

Paste-Mix – Mixes the waveform from the temporary buffer and the current
one.

Finally, the 'reset waveform on noteplay' check box can be set. This indicates that
whenever the instrument is played, this waveform is reset to its initial state. Since
some waveforms can be changed dynamically (via the WaveFX screen), it is
sometimes useful to reset the wave to its initial state. 
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The Sample Editor

The sample editor can only be reached from the instrument editor. If you don't know
how, please read the chapter about the instrument editor first.

If a sample is attached to an instrument, the timbre waveform will not be used
anymore. If you however remove a sample from an instrument, the timbre wave will
be used again.

In the sample editor you can set the specifications of the sample which is attached to
an instrument. On the top of the screen is a graphical representation of the sample.

Click on one of the check boxes next to the words startpoint, looppoint or
endpoint to select which value should be altered if you click on the graphical
representation of the sample. This way you can visually set the start- en end- and
loop points. You can also set them manually by clicking on one of the corresponding
numbers, holding down the stylus and dragging the stylus.. The blue bar on the
screen represents the start point, the yellow the loop point and the red the endpoint.
The loop point is only used if lopping is enabled. You can do this by selecting the
'Looping enabled' switch. Right under it is a switch which specifies how the sample
should be looped: one way, or two ways. This switch is called 'Bidirectional
looping'. Typically, bi-directional looping sounds better.

To load a sample (this should be a mono wav sound) select 'Load Sample' from the
'File menu'.
You can also use the same sample more than once in other instruments. This will
make sure the file size of your song doesn't increase too much. Select the sample
you want to play by selecting it in the 'Sample sharing' drop-down box. You can
set new start-, end- and loop points and re-use the same sample. Make sure to first
delete the sample (using the 'delete sample' button) which was loaded into the
sample slot. If not, that sample will still be loaded but not used.
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The WaveFX Editor

The 'WaveFX' section of the instrument editor let's you tweak the various effects out
of which the instrument is built. If the sound is a sampled sounds, no effects are
possible. The effects are only used to create rich and dynamic waveforms. To get to
the WaveFX screen, go to the instrument editor using the 'I' button on the menu bar
at the top of the screen. Now click on the 'WaveFX' button on the bottom of the
screen. (First make sure that there is no sampled sound selected (The red light
should be off).

There can be 4 wavefx layered per instrument. Use the 'fx nr' control to select which
of the fx you are altering.

Now you can select which of the WaveFX you want to use. Use the drop-down box
in the middle of the screen to select the effect.

Some of the effects use 1 source waveform, some use 2 source waveforms, and all
use a destination waveform.

There are effects which combine 2 waveforms (2 source) and manipulate these to a
third one (1 dest). One typical example is the wavemix effect. This effect mixes the 2
source waveforms into a third one (the destination waveform). The speed with which
it is mixed is set by the 'fx spd' slider.
The negate effect is a typical example of an effect which only influences a
destination waveform. It influences it by periodically flipping its contents around the
Y-axis. This results in a sound similar to a pulse wave with varying pulsewidth. Again
the speed of the effect can be set with the 'fx spd' slider.

When editing effects don't forget to click on the hardware buttons of your device to
actually hear and see what you are doing. All waveform displays change in real time
(the speed of updates can be set in the settings screen  (for slow devices a low
update speed is recommended)).
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An example of a complex effect is the filter effect.  This effect uses 1 source
waveform and a destination waveform. The effect has 2 parameters called 'Center
freq' and 'bandwidth' with which the effect can be tweaked.

The variation of these effect parameters can be done automatically over time by
letting them oscillate according to one of the available waveforms. To accomplish
this, click on the 'osc' text above the oscillation waveform display. You are now
redirected to the familiar wavebank screen. Select one of the waveforms which are
not used and click on 'choose'.  You are now brought back to the WAVEFX screen.
By drawing directly into the small oscillation waveform display (or by going to the
waveform editor to be edit a waveform with more precision) you can actually draw
how the parameters should change over time. The check box next to the oscillation
wave lets you decide which of the 2 parameters should be oscillated! The 'osc spd'
slider lets you specify with what speed the oscillation will take place.

If you don't want to oscillate the parameters anymore, click on the 'osc' text above
the small oscillation waveform display. You are now in the WAVEBANK screen. Here
select the 'disable' button, which disables the use of a waveform.

Finally, the 'reset on notep' check box at the bottom of the screen, lets you decide if
the effect parameters should be reset to its initial settings every time a note is
played. This can be useful if you want the effects to change constantly even when
new notes are played.

Don't forget you can layer 4 of these effects simultaneously, allowing very complex
sounds to be made!

All possible WaveFX
Negate – Flip the waveform around its y axis (simulates pulse width
modulation)

Sweep – Distort the wave by sheering it. (gives a very rich robotic sound)

Averager – Averages the wave. This can simulate very soft string sounds
(like the strings of a bass)

Wavemix – Add 2 waveforms together to form a third! (can give nice effects
if you set one the source waveforms equal to the destination waveform)

Filter – A bandwidth filter which filters out certain frequencies. 

Filtwhistle – A filter which has a more high pitched quality to it

Morph – lets one waveform morph into the other

Dynamorph – lets one waveform morph into the other, but does so that not
the whole wave is morphed in one go, but spread out over the entire
waveform.

Distortion – Amplifies a waveform. When the wave goes out of bounds it is
reflected back giving a really distorted sound

Scroll left – Scrolls the waveform to the left (Nice when the wavelength of
the waveform is actually less)

Upsample – Up-samples the waveform periodically.

Clipper – Same like distortion but now the samples which go out of bounds
are clipped by the wave range.

Lowpass – a lowpass filter letting only certain frequencies through
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Highpass – a high-pass filter letting only certain frequencies through

Bandpass – a bandpass filter letting only certain frequencies through

Metalnoise – noise generator

Squash – shrinks a waveform (sounds very characteristic)

To fully understand the various effects the best is to make an instrument (with the
volume set to full) and play around with the effects. You can also load in existing
instruments and see how these have been created.

(Please note that it is also possible to alter these parameters during playback from
within the patterns! Read the Pattern editor chapter about how to do this!)
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Appendix

Support
There are 2 ways of getting support. First of all if you can't get the program to run or
have something else which really requires the aid of us, feel free to contact us at:
support@klaar.com

If you have questions about the use of the program or various functions then you can
also jump to the public bulletin board what you can find at:

http://klaar.com/cms/index.php?option=com_simpleboard&Itemid=40

Here you can discuss with other users, and drop new ideas or suggestions to the
developers.

Information for Developers
There is also a Syntrax replay library available for CE-developers. The player is very
fast and is especially designed for incorporating music in your CE titles in an easy
way. The Library comes with a full API with which you can playback songs, as well
as sound effects, instruments and receive callbacks when certain parts of the song
are reached.

Inquiries should be sent to:  Syntrax@klaar.com
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